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KestrelSpec™ application software (the "SOFTWARE") is Copyright © Rhea Corpora-
tion 1991-1995 with All Rights Reserved. You do not obtain title to the SOFTWARE. You
may not copy the SOFTWARE, except that you may make a backup copy of the
SOFTWARE for your own, personal use. You may not transfer the SOFTWARE via an
electronic network, nor may you place the SOFTWARE on a file server.

Your copy of the SOFTWARE is licensed for use with one computer atatime. You must
ensure that only one copy of the SOFTWARE is in use at any given time. You may
transfer the SOFTWARE and the license to use to another party if the other party agrees
to accept the terms and conditions of the licensing agreement and written notice is sent
to Rhea Corporation specifying the name and address of the new licensee. If you transfer
the SOFTWARE, you must at the same time either transfer all copies to the same party
or destroy any copies not transferred. Unauthorized copying or use of the SOFTWARE
is a violation of United States and international copyright laws.

* GOVERNMENT LICENSEE. If you are acquiring the SOFTWARE on behalf of any unit
or agency of the United States Government, the following provisions apply:

The Government acknowledges Rhea 's representation that the SOFTWARE and its
documentation were developed at private expense and no part of them is in the public
domain.

The Government acknowledges Rhea's representation that the SOFTWARE is "Re-
stricted Computer Software" as that term is defined in Clause 52.227-19 of the Federal
Acquisition Regulations (FAR) and is "Commercial Computer Software" as that term is
defined in Subpart 227.471 of the Department of Defense Federal Acquisition Regula-
tion Supplement (DFARS). The Government agrees that:

(i) if the SOFTWARE is supplied to the Department of Defense (DoD), the
SOFTWARE is classified as "Commercial Computer Software" and the Government is
acquiring only "restricted rights" in the SOFTWARE and its documentation as that term
is defined in Clause 252.227-7013 (c) (1) of the DFARS, and

(ii) if the SOFTWARE is supplied to any unit or agency of the United States
Governement other than DoD, the Governement's rights in the SOFTWARE and its
documentation will be as defined in Clause 52.227-19 (c) (2) of the FAR.

RESTRICTED RIGHTS LEGEND. Use, duplication, or disclosure by the
Governementis subjectto restrictions as set forth in subparagraph (c) (1) (ii) of the Rights
in Technical Data and Computer Sofware clause at DFARS 252.227-7013.

Rhea Corporation, Three Christina Centre, 201 N. Walnut St. Suite 1000, Wilmington,
DE 19801. tel: (215) 922-7703 fax: (215) 922-7706 email: rheacorp@aol.com

The disk on which the SOFTWARE was delivered is warranted for 90 days from the date
of shipment to you. If you find the disk to be defective within that period, return it for an
exchange. Rhea Corporation does not warrant, guarantee, or make any represen-
tations regarding the use or the results of the use of the SOFTWARE or any
accompanying written materials in terms of their correctness, accuracy, reliabil-

ity, currentness or otherwise. The entire risk as to the results and performance of

the SOFTWARE and written materials is assumed by you. Some states do not allow
the exclusion or limitation of implied warranties, so the above exclusion may not apply
to you. In that event, any implied warranties are limited in duration to ninety (90) days
from the date of delivery of the SOFTWARE. This warranty gives you specific legal rights.
You may have other rights, which vary from state to state.

Macintosh ‘and the MacOS logo are trademarks of Apple Computer, Inc used under
license. Kestrel, KestrelCal, KestrelSpec and MacSpectrum are trademarks of Rhea
Corporation.
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How to Use
This Book

4
The best way to learn KestrelSpec is to explore its data-
acquistion and data-visualization tools on your own. This is
a book of hints to guide you in your exploration.

m If you want a brief lesson on getting started with
KestrelSpec, see "Learning KestrelSpec."

= When you want to find out more about using the CCD
detector and spectrograph to acquire and display data, flip
through "Using KestrelSpec."

m For details on various menu commands, spectrograph
control, and scripting see "Reference."
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Chapter 1:

Learning
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Learning
KestrelSpec

How to begin:

* Insert the KestrelSpec disk. For faster performance, copy the
KestrelSpec program onto your hard disk by dragging its icon to
the hard disk window.

» Double click on the document icon titled "Neon-Scan Movie."
KestrelSpec will automatically start and load the document.

* In a few seconds, the screen will look like this: (the actual
window size will depend on your monitor's size).
% File Edit 5et HAcguire Style Display Process Setup
] KestrelSpec EHEI
E20000
1:DATAD4S 1
Spectrum title
453000
i)
|_
=
)
[
[
2170001
T ﬁ
-10323 . . .
1 155 375 562 750

F1xXEL

=l 1EI>|E][ ]' '

Plot Cl 1 213
L] 2| ED [T]E] - {urﬂﬂlﬁﬁﬂﬁ}
[« H>][< #Y>][«<¥>][F[int |[abs] [ Enter | [~ |7 (@ (0]

This is the Control Palette. It has tools for setting up and chang-
ing displays of spectra and images, moving the spectrum cur-
sor, selecting areas, and basic math operations.
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Control The control palette is a floating window which gives quick access to
Palette a number of tools. Its appearance depends on whether the display
shows a spectrum curve plot or an image. Many of the control

palette tools are discussed in this chapter on the pages shown in
the figures below.

Curve-Plot Mode

dragging hand (p.22)

overlay-plot
setup tool
(p-14,18,20) X scroll button Z scroll button  math-operation
(p. 15) (p-7) buttons (p.27, 32)

I Plot I l

| |[c|r1[1][21[31
A0 20 _ (0356
A/ ¥ |Res (< By )(< #¥ > ][y >} [int ] (abs] [ Enter | &) (78]

zoom box (p.9)
peak point qUiCk Z00Mm (p24) keypad (p14120)
continuous

o0 . finder editor
(XY) zooming (p.16) (p.23)
tools (p.21)

Image-Display Mode

image-point readout (p.32) image|b(rigr3]t2n)ess
control (p.

=62 Y=50 (33213093 1= 10659 gnmmmelT 6 N

EeIEE SIS I0E) (o
;;_:.i:; iy M?M o i 4 8 . I E]
] (<32« 89 2 JE ¢ 2 [ [in1 | (abs) [Eater )

I |
(a2 12 %)
ERENENEY
= J 28] %)

The zoom box can be used to select an area of the image for copy-
ing to the clipboard. Hold down the option key to have the mean

and standard deviation for the selected area displayed in the upper
right part of the control palette.



In this book, the
following symbols

indicate specific

actions. means click . means drag .
Position the pointer, Position the pointer,
then briefly press press and hold the
and release the mouse button while
mouse button. you move the mouse,

then release the
mouse button.

* Click the X,Y autoscale button in the control palette.

Click !E

This sets the Y axis scale to show the entire range of data,
and also causes the X axis to only include the part of the
spectrum that has non-zero data.

» To show the X axis in nm (wavelength) units, choose the
Style:Calibrate X Axis:Wavelength menu.

Here's how:

Press

Display Process

Twvywvwvyw

Contour Ima
Release

Calibrate H AHis
Tweaks...

Wavelength {nm;}
Raman Shift {cm-1}

l
wTitle{s} |

v AHes
Curve Bands on Image




Zoom in on an area of the spectrum:

« Click ﬁ

» Then drag in the plot window:

Press

Ji

S50 1 Sad .3 585.5
WAVELEMGTH mm Release

As you drag, a dotted outline encloses the area you select.
When you release, the plot is redrawn to show only the area
you selected.

* Turn off the zoom-box tool if you don't want to zoom further:

Click

* Drag the spectrum title to a different part of the window
(after clicking, wait for the pointer to change to a hand be-

fore dragging): _
CIiCk Release

1 :DHTHD'ltal—/_

|

The title will stay in its new location.
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Change the title of the spectrum:

» Choose the Display: Curve Info menu:

UG Process  Setup

Curve Info
R5-237 Terminal

This opens a window with the title, general info and spectrograph
info for the curve:

Curve Title |DATAD481

Curve Info |Created 06/22/93 at15h33m04ds; ET= .9s; Exps= 1
Gain= 1; Image 5ize= 512 % 10; Group 5ize=1 % 10;
Origin= 23, 204

Spectrograph Info For This Curpe:

Known Wavelength = 580 nm at Pidel | 251.752
Spectrograph Angle = 12.000001 Deqgrees

Spec. Focal Length = 500 mm

Grating Grv. Density = | 1200 g/mm

Detector Pidel Size = 22.195239 microns

Excitation Wavelen. = | 514.5 nm

» Select the edit file with the curve title:

Double-click V
Curve Title |(DATAD481

* The title will hilight itself.

Curve Title (UGIGLIEEY!

* Type a new title, then click the "OK" button.

Curuve Title [Spectrum




Setthe X, Y
range of the
plot with these
edit fields.

These buttons
let you adjust
the appear-
ance and
behavior of
the axes.
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Change the X, Y axes:

* Choose the Set:Axes menu:

s Acquire  Style  Disp

Axes...

The Axes dialog window opens:

Axes

H Mau | 500 |pixel

HMin | 356 |

¥ Max | 635567 |

¥ Min EREGEIIING

[]Set H Cursor Range

[]2ero ¥ Origin []Show ANl 3D 4
[] Always Use Curve 0 for Cal

(<] Show Axis Labels [ ]Linearize Y

<AUTO > <AUTO>
H: means use
the default
y: COUHTS X axis
) descriptions
(nm, cm-1)
7. CURLE HURNBER

I
These edit fields set the

description that appears on
the X, Y and (forchannel
profile plots) Z axes.

» Turn on "Linearize X" to set X range directly in wavelength units.

Click Ikimaﬂrize H
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» Type 550 and 600 for the XMin and XMax values.

H Max | 600 | im

H Min | 550 |

* Click "OK."

COUMTS

BEa000

432000

217000

1:5pectrum

JII-

= 13400
=50

562 .5 575 587.5 500
WAUELEMGTH mm

217000+

The plot will be redrawn to show the new X axis range. The spec-
trum curve does not cover the entire range, because it has valid
data points ("pixels") for only a fraction of the range.

“Linerarize X Axis" makes the divisions on the X axis uniformly
spaced in the calibrated units (nm, cm-1, etc.). It also "locks in"
the plot X axis to the specified calibrated range.

» Select the X autoscale button:

Click

The plot X-axis range will "snap” to the actual range of valid data
points for the displayed spectrum. (Hold down the option key

R I N D A YA U i e P ) A e N

|

—19323

2716

575 .8 530.0 Sa4 .2 S88.5
WAVELEMGTH +m




About the
Spectrum
Movie
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» Again, choose the Set:Axes menu:

Y quire Style Disp

Axes...

e Turn off "Linearize X."

Click kinearize H

* Click "OK" to exit the window.

Display the open document as a spectrum movie:

LG Process  Setup
patrol Palette

Spectrograph
Spectrum Catalog

Active Image £
Dark {Background} Image 3J
Hihite (Fiat-Vield mage

The 50 different spectra in the document file will be plotted in rapid
sequence. Since each spectrum was obtained (using KestrelSpec's
automated spectrograph control option) with a slightly different
spectrograph wavelength setting, the peaks in the spectrum appear
to move to the left as the movie runs. The X axis wavelength values
also change as the movie runs.

To slow the movie to one frame per second, press the option key
on the keyboard.

To stop the move, click the STOP button on the control palette (or
return on the keyboard).

Click STOP or return.



Overlay Plots
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Plot a different spectrum:

* Click the "5" button on the Control Palette (or on the keyboard).

« Click the "Plot" button.

g
o (o

Spectral curve no. 5 is plotted. The wavelength units on the X axis
are automatically updated for the new spectrum, since this
spectrum's pixels cover a different wavelength range.

Create a multi-curve (overlay) stacked plot:

* Click on the stacked-plot tool on the control palette:

Click

i

[ =]
= 5D
il

The overlay-plot dialog window will open. Set up the First, Step,
and Last values as shown:

Curves in Overlay Plot

First [N
step [5_ |
Last E

* Click OK.
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The stacked plot will be drawn from the top to the bottom of the
display window using curves 1,6 and 9:

active ., GE29000
(flashing) £ 453000 1:Spectrum
spectrum = 2170004
[}
-19255 . . .
curve 571.6 575.8 SS0 . 1 554 .3 SE28.5
L, BE9000
E 452000 5: OATAO4SG
= 2170001
0 19353 : : : A
5741 578 .4 522 .6 526 .8 591.0
., DE9000
E 453000 11:0ATAO491
= 2170001
S _jg353 . : A
576 .6 520,49 585 . 1 5503 503 .5
WAVELEMGTH rm

The top spectrum will be flashing to indicate that it is the

"acti

ve curve"

(or "active spectrum") in the overlay plot.

Each of the 3 plots has a different X-axis wavelength range.

* Click in the right arrow of the X scroll button.

KA
"

L Bt
[« H>][< HY »][< ¥ 2] [

1

B

The spectrum cursor (small dot) will move along the active curve:

Spectrum cursor
(Move it with the
X scroll button, or
drag it with the
mouse.)

]

BEa000

E 4520004 1:Spectrum |

= 217000;

(i} — 103253 mr__ . e .
571.6 575.8 520, 1 584.53 538.5

o D000 &: DATAD4SE §: S‘E‘g # 1

£ 4a3000q = <575 . drm>

= 217000

D _qgass . . —
574.1 S572.4 582 .6 536.5 591.0

L, BEI000

E 4532000 11:0ATHZ491

= 217000

0 19353 : o

585, 1 580.% 503.5

5?6 530.9

HWAVELENGTH nm

The cursor display box shows the counts (), pixel (X) and calibrated
X value for the position of the cursor. The calibrated value is en-
closed in brackets < > when KestrelCal is in use. (The box can be
dragged to another position in the window.)
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Change the active curve in the overlay plot:

« Click in the lower arrow of the Z scroll button:

Click

1
<Y

GEa000

] . W= 234

E 453000 1:5pactrum ¥= 114 # &

g 2170004 <577 . 9nm*

“ —10353- . . =1 e
3716 oa.8 5801 S84.3 SB8.5

., BE0000

E 4520004 S DATHO426

= 2170004

0 g5z A . =
5741 V8.4 S82.6 S85.8 S91.0

The spectrum cursor will move to the next curve in the display.

Use the peak finder:
* Click in the peak-finder tool:

Click

The peak finder "bouncing ball" will show the highest peak in the
spectrum. The peak-info display box details information about the
peak.

[ ]
Peak—finder/ PEAK % 1

F . - Y= B49670
bouncing ball 585.1 FLWHM=. 165
AREA=2527540

M
=] 286,38 291.0

To quit the peak finder, hold down the shift key and click in the
peak finder tool:
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Linearize the overlay plot X axis:
* Open the "Axes" dialog window again using the Set:Axes menu,
or double-click on the plot axis:

Double zﬁgnnnj I I
click _igas3
574 . 1
* Click "Linearize X" to turn it on. Set the X range to 580 to 590 nm.

Axes
then set
XMax, | | HWMaxr [ 590 | im
X Min .
as shown H Min | il | Cancel

¥ Man | 688642 |

¥ Min |-19353.1 |

[]Set H Cursor Range

[] Zero ¥ Origin [ ]Show AN 3D 4
[] Always Use Curve 0 for Cal

[<] Show Axis Labels [<]Linearize H

/
D First click here

* Click OK. The spectrum curves will be redrawn with wavelength
values at the same X axis locations for all curves:

. 629000
E 4330004 1:Spectrum ﬂ
= 217000
0 _joz6e3 : . —
580 0 5825 505 587 .5 50
. BE9000
E 4530001  6:DATAO4E6 A
= 217000
D 1023 . . —
5800 5825 55 587 .5 50
., BE9000
E 4530001  11:DATAC4E1 }\
= 217000
S [l aXc: . ] =
580  S582.5 585 587.5 540

HAVELEHGTH rim

"Linearize X" makes all plot X axes "lock in" to the specified X Min
and X max values.
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Change the stacked plot to a 2D overlay plot:
* Click on the stacked-plot tool to turn it off:

Click —_ Stacked-plot tool

ot [y

-

;,. 3D overlay-plot tool
Overlay-plot tool

This puts the display in 2D overlay-plot mode :

GE9000
1:5pectrum
& : DATAO4 36
11:0ATAO4S 1
453000+
o
'_
=
S
[
O
217000
W4
-19263

S0 5825 535 S87.5 540
WAVELEMGTH mm

The 3 spectra are now plotted in the same area with the same
axes. Since "Linearize X" is in effect, the spectral peaks of the
same wavelength are superimposed. (The slight mismatch
between peak locations, on the order of £0.2 nm, gives an
indication of the accuracy of the calibration used by this file.)

Change the 2D overlay plot to a 3D overlay plot:
* Click in the 3D overlay plot tool. This puts the display in
3D overlay plot mode.

(If the 3D plot is not entirely inside the display window, select the
Set:Reset Plot Layout menu to make it fit.)



3D Overlay Plot

19

1:Spectrum
G :DATARO4 26
SEa000 11:0DATAO49 1
4532000 h

COUMTS

217000 h 7
/ n/

SE0 S582.5 585 537.5 530
WAUELEHGTH mm

—19490

* Click once in the display window and hold the mouse button

down.
@ 453000 L’
=
=
8 217000 /

The 3D plot handles will appear; release the mouse button:
1:5pectrum

Click

& DATAO4EE6
S39000 11:0ATAO49 1

COUMTS

/! o

S582.5 585 587.5 530

.................. RURLEHATH i

3D plot handles

* Drag the front 3D plot origin (round dot) a small distance to the
right.

BEa000

|
453000

: £
2170004 L !,
: I
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The 3D plot will be redrawn to a new perspective:

E29000 1: Spectrum
5 453000 & - DATAD4EE
é 11:DATAD4S1
2 2170001
— 1940 A

\ | : H\
580 S582.5 585 557.5 590
LAYELENGTH mm

(The other handles can be dragged to change the size
of the 3D plot.)

* Turn off overlay-plot mode by clicking in the 2D overlay-plot tool:

(Now only one spectrum should be plotted in the display window.)

* Plot spectrum curve 25:

|
C”Ck [ CIr ][l_]
Click r—ﬁ—j[—a—] 5
(e J 218 9)]

Click m

* Click the XY autoscale button:

Click CHY »
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a3a000

45330001

217000

B |

523.7 587.4 502 . 1 S06.3 B00.S
WAUELEMGTH mnm

=19013

¢ Click in the X-zoom tool. The plot will zoom in X.

Click [[%,
212000
120000
6900
—SEO04— i . :
S350 S90.0 0 S92 1 S94.1 5961

WAVELEMGTH mm
(The Y axis scale changes if 'Auto Y Scale' is enabled.)

* Click on the right side of the XY zoom tool. The plot will pan to
the
left.

Click
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212000

1390010 1

G500 1

. JL

Se0.8 S501.8 503,40 505.0  S508.0
WAVELEMGTH mm

=3200

Using the dragging hand tool:

* Click in the dragging hand tool to turn it on:

Click .

* Move the pointer to the plot window area. The pointer turns into a
hand indicating it is ready to drag the plot. Click in the plot and
drag it a short distance as shown.

212000

139000

Release
0

Click

BEI00 1

JL

=3300 r r r
289,82 591.8 293.9 293.9 393.0

HAVELEMGTH rim



After you finish dragging the plot, if will be redrawn so that
the curve is in the new location. The plot axes are updated
accordingly.

157000

24400

12100

—G0342

S01.9 594.0 S96 .0 S35.1 GO0, 1
WAVELENGTH mm

* Turn off the dragging hand tool:

Click

Editing spectrum points:

» Select the Set:General Settings menu:

dage-foequire Style Display Pro
General Settings...

KestrelSpec Settings

* Click on i
‘Auto <Y> Scale' to ?ash Active Curve
A

turn it off. Click uto <¥> Scale

* Click OK.
* Click on the point editor tool to turn it on:

Click T

23
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* Move the pointer to the plot window over a peak. Drag the peak
down so that the point is at the base line level:

S0400 Jv="SE0Z7
. *r= 422 & 25
Click <507 Brm>
20200
191004
Release /
—-1101

SO6.8 5971 597.5 S507.0  S508.3
WAUELEMGTH fm

(To cancel the editing of a point, select the Edit:Undo menu.)

» Repeat the "drag down" process for the other points in the peak:

) el g
(Of course we recommend you only edit data for valid scientific
purposes, e.g. for cosmetic removal of a known noise peak.)

Using the quick-zoom tool:
* Click in the quick-zoom tool to turn it on:

Click
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» Move the pointer so that it is centered over a region of interest in
in the spectrum plot. Click the mouse.

lr

502 .1 506 .3
SLEMGTH nm

Click

The plot will zoom-in by a factor of two in both X and :
235000

1170001

- 15301 A

= 119603 r r r
S90.3 592.4 294 .5 o96.6 592.°7

HAVELEHGTH #m
(The plot will zoom out if the optiion key is down.)
» Click again on the quick zoom tool to turn it off:  Click '
» Choose the
Edit:Clear All Curves
menu to erase all set Acquire Style Displa
spectra.

I.Indu\ K2

A caution

alert window S B
will appear, Copy L
click OK to Pasia ST
confirm the clear. Clear Active Curle

Select Al #H

Empty Trash {Clear Curyes} #K
Create Overlay Plot...
Overlay

Clear Keypad Stack
Clear All Curves




Performing curve arithmetic:

* For faster plotting, select the Set:Axes menu and turn
off "Linearize X."

e Acquire  Style  Disp

Axes...

Click hinearize H to turn it off.

* Select the File:Open menu:

File “"- Acquire &

Open

* Open the "Sample Curve Data" file:

O Raman Curves
O Raman Images
[ sample Curve Data Cancel

5 (_tee )

* Click the <XY> autoscale button.

The display window should look like this:

Gz26
1:5ample_1

2431

COUHTS

4591

el i

453 .6 469 .0 479 .4 439.9 S00. 3
LAUELEMGTH +m

370

26
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« Click the 5 button, then the Enter button:

s
Click ) v

T o

Click

« Click the 4 button, then the Enter button:

Click %%

TOro

Ciick

* Click the - (minus) button:

Click

Curve 4 will be subtracted from curve 5, and the result will be put
in the next available RAM curve memory (# 11 in this case).

oa2
11:# 5 — # 4

Q5. O

et b

COUMTS

- 1656

453 .6 459 .0 479 .4 439.9 500 . 3
UAVELEMGETH mm

Other dual-operand curve math (+,/,*) operations work in a similar
manner. Single-operand operations (log, abs) will use the active
curve unless a curve number is entered on the keypad.
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Using the spectrum catalog:

* Select the Display:Spectrum Catalog menu:

TG Process  Setup

Control Pilzfte
Curve Info  °°e %1

CCD Temperature “*o,
Spectrograph Controlde, #°
Spectrum Catalog

* Click the <XY> autoscale button:

Cick

The display window will show the spectrum catalog , which has a
scrollable view of up to 40 "mini" spectrum plots at a time. You
can cut, paste, clear and "open" the mini-plots in ways similar to
the icons on the Macintosh desktop.

* Clear curve 11 by dragging its mini-plot to the spectrum trash can:

Click
1 2] 11 1:5ample_1
l 2:5ample_2
d at. L | 3 Sample_E
= 4 Sample_4
2 7 S:Sample_ 5
G:Samp | e_f
i whi J‘ 'uu"' T Sample_7
2:5ample_g2
2 =2 Q: Samp le_9
| ““ 10: Samp |l e_10
_|_.J...-.l.u|. 11:# 5 " 4
4 Q
MJ—J—M

i Release H
{:j i
ITR-YEY Il

* To finish the clearing, select the Edit:Empty Trash menu. (To
select more than one mini-plot at a time for dragging to the
trash, hold down the shift key and click once on each mini-plot.)
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Cutting and pasting spectra in the catalog:

* Click once on the mini-plot for curve number 8:

Click = 8:3a
g 9:50
e 10:5

1 i

* Curve 8 is now the active curve, and it will flash.
* Select the Edit:Cut menu:

5et Hcquire Style Displa

firrsin P

The mini-plot for curve 9 moves into the position formerly
occupied by curve 8.

* Click once on the mini-plot for curve number 3 to select it:

» Select the Edit:Paste menu

ket Acquire 5tyle Displa
finiin I

The mini-plot for the previously-cut curve will be inserted into
curve memory number 3, pushing the other curves up by one
memory location to make room.
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The edited spectrum catalog has the spectrum that was
originally in position 8 now occupying position 3:

:Sample_1
(Samp | a2
JSample_2
JSample_3

1 =] 1
2
]
4
= 7 = Samp le_4
=]
7
g
=]
1

cSample_S
(Samp | e_G
(Samp e
JSample_9
0:Sample_10

g q
T .IlL]L

* Select a mini-plot in the spectrum catalog
for plotting:
» Double click on mini-plot number 5:

Click 3
Click

» The normal plot window display will appear with the selected
spectrum:

1690
S:Samp le_4
1060
o
'—
=
|
(]
(]
azs{ MLh_JiM;_JIJ—J‘-A
-208 : : :
458.6 459, 0 470 4 420 .9 S00.3

HAVELEHGTH rnim
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Open an image file:
* Select the File:Open menu:

Q1N Edii—Set A

cquire %
Open ;

» Double-click on the "Background image for Raman" file:

g Raman Images ¥

Click
Click [1 Background image for Raman [

[0 Raman image DMS0 632.8 nm

* Select the Set:Set as Background Blank menu:

ﬂ-mnina\stgle Display Proco

5et as Background Blank
5et as Flat-Field Blank

* Again select the File:Open menu:

Q1IN Ehii—Set A

cquire *
Open E

* Double-click on the "Raman image DMSO 632.8 nm" file:

= Raman Images ¥

[ BYoigtyggnd image for Raman |+
[0 Raman image DMS0 632.8 nm

(An alert may ask if you want to clear existing image(s). Click
Yes.)

The "Raman image" file will now be shown in the display window.



Image-Pixel
Readout

Image
Brightness
Control

Image
Arithmetic

32

* Move the pointer over the image display. The pixel location and
intensity value are shown in the upper left area of the control
palette.

Actual pixel Pixel location Intensity
position before binning value

I I 11 1
[Oi=363 Y=13 ¢385;4412 I= 1030

GEEET T jewsl g, |1

* Click in the small white rectangle in the top middle of the
control palette (this changes the image display brightness):

=363 Y=15 (S50, 4413 = 1030
SEE T e g, |12

il et Emmaiia 4 8 (T |GG
» The image display is updated. The intensity scale (color-code) at

the right side of the display will have values that are one-half the
previous settings.

Intensity scale

Subtract the background image:

* Click the - (minus) button:

Click
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After subtracting the background, the image display will look like

this:
|
| Raman image OMS0 632.2 nm
| L4 | | ‘
i
| Bl
[T
‘ I
|

Make spectra from the image:
* Select the Setup:Image->Curves menu.

o}

Rcquire.s. %G
Binning... ™, %#H
Camera Eunfiﬁﬂ{ptiun...
Cal Curve...
Curve Memories...

Image->Curveis}...

* Type "4" in the top edit field of the window that appears.
Image->Curvels)

Image-> curvels)

This assigns the top one-fourth of the image rows to the 1st
curve, the next one-fourth of the image rows to the 2nd curve,
etc.

* Click OK.

* Select the Process:Copy Image to Curve{s} menu:

Process

Copy Image to Curvels} &;

V
* Click the Plot button (or return on the keyboard). Click m
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* Click the <XY> autoscale button.

Click HY >

» The display window shows the first of the 4 spectrum curves you
made from the image. The wavelength values are 0 because there
is no calibration set up for this spectrum yet.

23600

11:0ATAOOO 1
162004
0
|_
=
>
[
O
T9E0
|
—234 r r T
0 1] 0 ] ]

HAVELENGTH nm

Calibrating Spectra with a Calibration Curve
» Select the Setup:: X Axis Calibration menu:

Acquire.> #b
Binning... #H
Camera Configuratia

H Axis Calibration...

Curve Memories...
Image->Curve{s}... 3=

* In the window that appears, type the values shown in the first
four edit fields. Turn on the two 'Select' buttons as shown.

Select:  Pixel Ualue
(<] 77 632.8
B 362 7.7

* In the "Laser Line" field type the value shown:

Laser Line (nm)|[632.8 |
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* Click the 'Update Cal Curve' button.

Click | I;IUpdate Cal Curve ]

* Click OK.

* Select the "Style:Calibrate X Axis:Raman Shift {cm-1}" menu.

Calibrate H Axis
Tweaks...

Raman Shift {cir=

The spectrum plot X axis will now be calibrated according to the
information you have provided:

-M5.7

275 .4 2107 .2 22034 4244 0
RAMAM SHIFT em—1

(A "real" calibration curve would usually require more than two
reference pixels, since spectrograph wavelength dispersion is not
perfectly linear.)



36
Laser-Beam * Again select the File:Open menu:

Profiler
Display

File |ipamt S|

cquire %
Open ;

» Double-click on the file "Laser Profile Image" to open it:

!ILF Demo Data ™
Click | O Casdr Profile Image 7]

Click

* Select the Style:Image:Image Fits Window menu to toggle it off:

Fositive #1
R Negative 32
¥ Pseudocolor #3
Calibrate ¥ Axis P
Tweaks... v Shoi-dgtensity Scale
Show Negatiye Pixels
<Title{s} %49 Dither Image Divpdg
« Axes + Image Fits Window ™-

Plot ‘hx 4
Line % 4
Fill kY 4
Font % b
A€ Positive #1
Lo iy %ﬁ'ﬁ'ﬁ{é‘%}axx Negative H2
Znge{ o Pseudocolor %3
Calibrate  Axis PP
Tweaks... fsﬁhﬂklntensitg Scale
Show Rl"ég:qtiue Pinels
«Title{s} #9491 Dither Imaﬁé{l{splﬂg
v HHes Image Fits Windis, /
Curve Bands on Image
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* Select the Style:Image:Y Profile Plot menu:

Calibrate H AHis

Positive #1
R HESTH A EH T Negative #*2
v Pseudocolor #*3

Tweaks...

sTitleis} A
+ AHes
Curve Bands on Image

Dither lIme
Image Fits
+ H Profile Plot
¥ Profile Plot

W Intensity Scale

* The display should now look like this (profile lines may be different):

Laser Profile Image
Profile Fow 61 Col &1

1ezz0| R

15552

14724

14015""
12248
12480
11712
10944
10176
Q402
2640
TETZ
7104
6336
5562
4200
4032
3264
2496
1723
Q50
192

o =

* Click on the horizontal profile line and drag it a small distance

Press

Release



38

The display will update to show the new profile row position:

Laser Profile Image
Frofile Row 78 Col

i,

B

16220

15552
14754
14016
12245
12420
11712
10044
10176
0405
240
a7z
7104
B236
SSES
4800
4032
226
2405
1728
OE0
102
o |

Click

i G
1 ar b

» Change the scale of the display by clicking once in the
white brightness-control rectangle in the control palette:

The intensity scale changes to 1/2 the former range:

The profile plots have intensity scales that range between 0 and
the maximum value shown on the color legend.

Laser Profile Image
Profile Row 72 Caol

T

B

s 160

TG
pci=l
Too2
G524
G240
bt tala]
L
a0Es
4704
43220
2936
2952
3165
2784
2400
2016
1632
1248
a6
420

0 [




* Click in the "c" (constant) button:

Click g@
)]

- Type EEDTEEEEE
gooo [CIr][ 1 ]2 ]3]
onthe [0 |[4 ][5 ][ 6 |
keypad [_= |[ 7] 8 ][9]

* Click in the "+" (add) button

Click |I!l|[::]l|ii'r
@O0
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This adds the constant value of 8000 to every pixel in the image.

The display is updated to show the changed image:

Laser Profile Image
Profile Row 3 Cal 61

zzean i

21104

2a568

23032.
26496
24960
23424
21228
20252
12816
17280
15744
14203
12672
111326
Q800
S064
6523
499z
2456
1920
284

o |

* Select the Display:
Active Image menu

to reset the automatic
display brightness. .

« Select the Setup: Camera Cov
Image->Curve{s} Cal Curve...
menu:

igquration...

Curve Memories...
Image->Curveis}...

#0b
#H

FE ‘
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* In the dialog window, type 10 for the number of curves.

Image-> curvels)

* Click OK.
* Select the Edit:Clear All Curves menu.

Acquire 5Style Displa

2o |

Fhan e

Liedr RHHHHU LAdUK
Clear All Curves

* Select the Process:Copy Image to Curve{s} menu:

Commmbh r.\ ao i

Copy Image to Curveis; 3

* Click the Plot button:

4
Click m

¢ Click the 3D button:

Click

* The values in the dialog window should be as shown below.

Click OK. Curves in Overlay Plot

First [N
step [1__ |
Last

=)

* (The 3D plot may not fit inside the display window if you have
changed the widow size. In that case, select the Set:Reset Plot
Layout menu to automatically make the plot fit the window.)
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* Click the <XY> button to autoscale the 3D plot:

* Select the Style:Fill:White menu:

* Select the Edit:Create Overlay Plot menu. Click OK in the dialog
window. (This redraws the 3D plot with the fill color you selected.)

*» The 3D plot should now look like the one below, with "hidden lines

removed."
RN
AL FmT T 14 3
= -naoToamm 15
IRl
AR ki ai =S|

2730001 10 DATAOOZ0"

2120001

152000 /

91000 : : : .
271 =00 30 60 200
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* Click in the channel-profile plot tool:

il

The channel-profile plot will be drawn below the 3D plot.

* Click in the X cursor scroll bar until the XY cursor (small dot =)
is in the middle of the 3D plot. Notice the channel profile bars
change height as the cursor is moved to different X positions.

il ]

I v I #*# | ea |l — |

* The plot display should look similar to that shown below:

Y= 101210
_——— - ._2' :l:= 325 i 4
N W G
L e
273000  BATAGO2G C W ¥
10 DATAGO20 XY cursor
2120001
1520004
.____‘___4.-"-
=
91000 : ' ' )
271 200 330 360 390
P 1 XEL
273000
91000 % ' ' |
: = 10

CURVE HUMEER cx=32%52

The highlighted bar in the channel profile shows the active curve.
(You can use the Z scroll button to select a different active curve.)

* To return the display to single-curve plot mode, click in the overlay
plot tool to turn it off:

Click
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Chapter 2:
Using
KestrelSpec

% File Edit Set 5tyle Display Process Setup
Acquire Spectra 3R =

20000 Acquire One Edposure 3#£E
Acquire One Dark 30
Repeat-Acquire Spectra [
Repeat-Acquire Image 3L
12000
) Boen Bhaitay
|_
5
o
G000
-
— 1000

- 100 925 1950 2075 4000
RAMAN SHIFT cm—1
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Setting Up |:| Slower Macs may need to have AppleTalk turned off when you are

to Acquire
Data with

the Kestrel
Macintosh
ST-6l

CCD Camera

e
x‘:'x
=

[]

running the CCD to prevent unrecoverable data-transmission prob-
lems. (KestrelSpec presents a special dialog if a data error occurs.)
This is more likely to happen if the CCD baud is set above the
default speed (19200). Current Macs usually enable KestrelSpec to
reliably operate the CCD at 57600 baud with AppleTalk turned on.

* Mount the ST-61 camera head on your spectrograph. Spec-
trograph manufacturers offer (or can make) a custom mounting
adaptor for the ST-61. Some spectrographs can also be had with C-
mount adaptors, which may be used with a C-mount threaded plate
for the ST-61 available from Santa Barbarbara Instrument Group.
Contact SBIG if you need detailed camera-mounting specifications
or drawings.

* Place a spectral-line source (Hg lamp, fluorescent lamp, neon
lamp, etc.) in front of the entrance slit of the spectrograph.

» Connect the cables to the ST-61 camera head and controller.
Connect the RS-232 cable between the "COM" port on the
controller and the modem (telephone) port on your Macintosh.
Turn on the power switch on the ST-61 controller.

* Open the "Chooser" under the Apple menu. If the printer is
using the modem port, switch it to the printer port (click on
the printer icon so that it is highlighted as shown at left).

Connecting
the
Spectrograph
Computer
Interface

[]

« If you do not have the KestrelSpec spectrograph control option
skip to "Focusing the System" on the next page.

« If your version of KestrelSpec has the spectrograph control option,
connect the serial cable from the "host computer” port on the
spectrograph to the printer port on the Macintosh. Turn on the
spectrograph power.

AppleTalk cannot be used when the spectrograph is connected to
the Macintosh printer port. If your spectrograph has a GPIB (IEEE-
488) interface that is supported by KestrelSpec you

can use it to connect to the Macintosh via a National Instruments
Macintosh GPIB interface. (See the Reference section of this
book for details on setting up the GPIB spectrograph interface.)

* Select the Display:Spectrograph Controls menu:

ITEIIGTT Process  Setup

Currve Info #1

Spectrograph Controls
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Spectrograph The spectrograph extention to the control palette will appear.
Computer Type the desired wavelength into the edit field shown:
Interface Double-click -

in this edit fleld,

then type the @ O eml

wavelength.

Click the Set

button (or Click

enter on @

the keyboard)

The spectrograph will then change to the desired wavelength.

(Use the <- or -> button to make small wavelength changes,

use the << or >> button to rapidly scan wavelength.)
Focusing « If KestrelSpec is already running, Quit it, trash any PREFS file you
the may have created, and reopen KestrelSpec. This insures that all

settings are in their default state.
System

« If you have not already done so, adjust the spectrograph
wavlength setting to correspond to the location of spectral line(s).

* Select the Set:Auto Background Subtraction:Dynamic menu.

* Select the Acquire:Acquire Spectra menu.
If this is the first time the system has been operated since power
on, a window will appear showing the status of the automatic
video offset adjustment.

* The CCD is exposed and read out in the default (750x30) binning
mode. (This will take about 10 seconds.) By default, the entire
image will be used to create a single spectrum curve.

» Examine the data. If the spectral lines don't appear, move the
source closer to the spectrograph entrance slit or increase the
exposure time (use the Setup:Acquire menu). Do the opposite if
the lines are saturated or the data is a constant, large value.

* Select the Acquire:Repeat-Acquire Image menu. Adjust the
camera head position and rotation so that the spectral line images
are perfectly vertical and as narrow as possible.

* Click the STOP button (or return) when finished.
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Acquiring MStHIE Display Proc

Data Acquire Spectra 3R
Acquire One EXposure #E
Acquire One Dark 30

Repeat-Acquire Spectra [
Repeat-Acquire Image 3L

Boen Bhuiiar

* All data acquisition is performed using the "Acquire" menu.

Acquire Spectra does a "complete" data-acquisition procedure
as specified with the Setup:Acquire menu (using the no. of
accums., no. of scans, etc).

Acquire One Exposure is the same as Acquire Spectra , except
it only does one "scan," and spectrum curves are not
automatically created when the display is in image mode. Control
of the software is returned to you if the exposure time is more
than a few seconds, so that you can work on other things while
waiting.

Acquire One Dark is the same as Acquire One Exposure , except
the camera shutter is kept closed and automatic dark-background
subtraction is disabled.

Repeat-Acquire Spectra continuously repeats the equivalent of
Acquire One Exposure and displays the data as spectrum plots.
(Press the STOP button, the return key, or command-period to
halt the process.)

Repeat-Acquire Image s the same as Repeat-Acquire Spectra ,
except that the data is displayed as an image instead of as
spectrum curves.

Open Shutter /Close Shutter is available in case you need to
manually open or close the camera shutter at any time. (Shutter
operation during data acquisition is completely automatic.)

* You can wire the Macintosh mouse switch to an output from your
experimental apparatus for synchronization. The system will wait
for a mouse-button click before proceeding if you hold down the
option key on the keyboard when selecting an Acquire menu
item. Hold down shift and option to make the system start data
acquisition when the Macintosh internal clock reaches the next
second. (Another method is to use KestrelScript commands from
LabView® or other program.)
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Setting Up « Data-acquisiton parameters are set using the Setup:Acquire menu
for
Data -
. Setup
Acquisition —

Acquire...

Acquire Setup

Exposure Time  ||0.1

[] Control Spectrograph:

Mo. of Accums. 1

Delay/Accum (s) | O

Start Mem. No. AUTO

Mo. of Scans 1

nm m
Wavelength © On
at 1st Scan 200
Wavelength
Step Per Scan 0

Delay/Scan (s] | D

Mew Curve Mame:

|
Spectrograph wavelength controls

(with spectrograph control option).

DATH

Automatically positions spectrograph

New Image Name:

wavelength at start of acquisition and
steps the wavelength by the indicated

IMAGE

amount for each scan after the 1st.

I
Acquire parameters

» Exposure Time is set in seconds, in 0.01 second increments.

* No. of Accums. is the number of exposures that will be co-added
into spectrum curve(s)

» Delay/Accum (s) is the time, in seconds, that the system will
pause between accumulation exposures. (Delay resolution is

1/60 second.)

 Start Mem. No. is the starting curve memory that will be used for
spectrum data during data acquisition. <AUTO> indicates that the
next available free curve memory will be used, and old data will
thus not be cleared.

* No. of Scans is the number of times that the Accum. cycle will be

repeated.

» Delay/Scan (s) is the time, in seconds, that the system will pause
between scans.

* New Curve Name and New Image Name are the root names to
which an index number is added for each data acquistion.



Binning of
CCD Image * To setup binning, select the Setup:Binning menu:

the way the image is read out from the CCD sensor.

Setup -

| Acguire.. —__

Binning...

_ Green rectangle shows
"Radio" buttons select from 4 readout area of CCD
different pre-set binning formats |
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Setting Up "Binning" in imaging spectroscopy refers to the the setting up of

Binning Setup OF .
[i%%i‘%?i?{% EHIHI ] E<] Al OB
i C
Hotate Image 90°
[] q oD
Left, Right, Group
Top Bottom 5iZe

Column 720 R
Row 76 O

CCD Binning: (148 W

Res. Mode: 730130
Pinel Size 11.54216 pm  Darkness (-7 to 15)

Use the pop-up menu * Test checks the row and column num
to select ST-61 group-size bers and rounds them off to multiples
(summation of pixels) mode of the group size.

* Open and Save enable saving and
restoring binning formats from disk.
» Darkness sets the image-display

darkness setting.

|:| * Only a single image subarray ("stripe") will be used if the All
button is turned on. (You can make multiple spectra from a single

subarray using the Setup:Image->Curve{s} menu.)



Setting up
Multiple
Image
Subarrays
(Stripes)

49
e Turn off the All button in the Binning Setup window to enable
muliple-subarray readout of the CCD.

Binning S5etup !
Click off [%%é:%é;aﬁ ﬁmﬁm] All

* Click the Active Rows... button:

[Active Humsk A

The Active Image Rows window will open:

U=ze FBRow to

Ooo0oo0oooOofdn

|

]

|

]

]

|

]

I
I
I
I
L1 |
I
I
I
I

Active Image Rows

Uze How to Fow Uze How +to  Fow Uze How +to  Fow

1 [ 1 1 [ 1

1 [] 1 1 [ 1

1 [ 1 1 [ 1

1 [] 1 1 [ 1

1 [ 1 | [

i | [ 1 [ L1

1 [ 1 | [

i | [ 1 [ L1

OoOo0o0o0oooOofdn

I |
I |
I |
I |
[+ ([ ]
I |
I |
I |
I |
I |

OoOo0o0o0oooOofdn

I I
I |
I I
I |
I |
I |
I I
I |
I I
I |

Ooo0oo0oooOofdn

1 [ 1 | [

[]

* In the "Row to Row " fields, type the first and last rows on the
CCD that you want to include in the first image subarray (stripe).

* Click the Use button for that set of rows to activate the subarray.

* Repeat the above two steps for each of the remaining image
subarrays.

* When you are finished, you can check the validity of the subarray
definitions by clicking the Test button. This scans the row
numbers make sure they are multiples of the current row group
size. It also verifies that subarray stripes do not overlap.

* Click the OK button to return to the Binning setup window. The
green rectangle and the other binning settings will show the entire
area covered by the subarrays.

» Enable the All button only if you want only one image subarray.
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If you have selected multiple image subarray stripes, you will see an alert
message when you close the Binning Setup window:

Auto update 'Image->Curveis}’
& ‘Custom’' curve bands to
match actire image segments?
Click OK in this alert window, unless you want spectrum curves that don't
correspond to the image subarrays ("segments"”). In the latter case, you

can use the Setup:Image->Curves menu to select the desired custom
curve-band definitions.

Camera Configuration
* Select the Setup:Camera Configuration menu to read or change
settings that affect the camera operation:

Camera Configquration

Serial Dimension Video Dffset (0-255)
Parallel Dimension 242 Com Port Timeout (s)

5T-6 ROM Uersion 03.07 Temperature

Antibloom % (1-100)

Mo. of Cleans

[<] Data Compression

Current Ulideo Output: 4011
Actual CCD Temperature: -29.9° C
Actual Cooler Setting: -30.0° C
Cooler-Capacity Useage: 100 %

il

[<] Control Temperature

[<] Anti-Blooming On

[JUse Shutter

(] Double-Correlated Sampling
Serial Baud:( 19200 "

[]Use Trigger In []Use Trigger Out

[]Trigger Only 1st Accum

[] Trigger Only 1st Scan

[]

* As of December 1994,

» The Serial and Parallel Dimension show the CCD chip size and

can't be changed.

* The ST-6 ROM Version* should be 3.07*to enable all binning modes

and triggering capablility. (Newer ROMs may be available.)

» Antibloom % sets the level of antiblooming control voltage

applied to the CCD. Usually the best setting is the minimum (1).

* No. of Cleans sets the number of times the CCD is read out im-

mediately before each exposure is made. Normally set at zero.

» Serial Baud: sets the data rate from Mac to CCD. Maximum data rate is

57600. Maximum usable data rate depends on Mac CPU. If data rate is
set too high the system may "freeze up" during image readout to Mac.

» Use Trigger In, Out - select if you need triggered data acquisition. See

the Appendix on this topic for details.
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Cam_era _ * Video Offset sets the bias voltage applied to the CCD sensor

Configuration output in order to bring the dark signal level within the minimum
detectable range of the analog-to-digital converter in the ST-6l.
This value is automatically set the first time the software talks to
the ST-61 camera, unless the offset value was read in from the
preferences ("PREFS") file.

|:| The video offset must be high enough so that the dark video
signal (displayed in the Camera Configuration window) is at least
a few hundred to a few thousand counts. The required video offset
value will change as the CCD temperature changes. If the ST-6I
readout is null data (all zeros) or saturated (constant, high value)
you need to increase or decrease the video offset value, respec-
tively.

* Com Port Timeout is the time interval the software will wait for a
response from the ST-61 camera after sending a command. (You
should normally not change this setting.)

» Temperature is the desired temperature setting for the CCD
sensor.

» Data Compression approximately doubles the speed of the
image readout from the ST-6l to the Macintosh, with no loss of
data precision. Leave this button turned on.

» Use Shutter causes the camera to close its shutter blade
while it is digitizing the image from the CCD. Normally this button
can be left turned off (thereby saving wear on the shutter). The
ST-61 uses a frame-tranfer type CCD that does not need shutter-
ing unless the light irradiance is high enough to cause "blooming"
into the masked area of the CCD during chip readout.

» Control Temperature enables the thermoelectric cooler.

* Anti-Blooming On enables antiblooming. This should normally
be on, with the minimum antiblooming value (1%) set.

* DC Restore Readout enables DC restoration of the signal.
* Double-Correlated Sampling achieves lower-noise readout at

the expense of slower digitization speed. Setup and system focus
run slightly faster with this turned off.
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Image->Curve{s}: Formatting Spectrum Curves from Images

Select the Setup:Image->Curve{s} menu to specify how spectrum
curves will be made from the current image-binning setup.

Acquire.. #b
Binning... #H
Camera Configuxation...
Cal Curve...

Curve Memories...

Image->Curveis}...

This field shows the Image->Curve(s)

number of curves { Image-> [6__ | curvels)

that will be made

from the image.

"Radio" buttons

select "Custom"” {3 Custom Bands Bail
(arbitrary) or
uniformly spaced @ Uniform Bands

curve bands. .
[] Entire Image -*1 Curve

[]1 Curve For Each Row

Shows how image -

rows are summed i Skip over EI
into uniform curve then add E
bands. rows to curve(s),

5 rows per curpe

Regardless of image
pixel group size, = Compensate For Horizontal
spectrum curves Image Pidel Group 5ize
always have the
same number of active-data

pixels when this button is on. A nonlinear resampling algorithm that
minimizes aliasing effects is applied to the image pixels to interpo-
late the required number of pixels for spectrum curves to achieve
an effective image pixel group size of 1. Thus, each spectrum-curve
pixel corresponds to one horizontally-ungrouped image pixel.

(This eliminates the need for re-calibration when the horizontal
image pixel group size is changed in the Binning Setup window.)
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Custom curve-band selection
* Click the "Custom" radio button and the "Set" button to select
arbitrary stripes of an existing image for spectrum curves.

Click it Custom Bands | af...
7
Click | (% Custom Bands w

Image->*Curve Bands

U=ze ‘M to M2 U=e 41 to Y2 Use %1 to Y2 U=ze ‘M to M2
B [=zo J[=s (0O O J0C 10 O 0 10 O]
B [s= J[z= 1|0 [ JC 110 O 10 110 10
B [es Jrue |0 O J0C 110 O 10 110 O]
O o Jo 10 o J0 110 O 0 108 10
O 0o 10 O J0 110 O 0 1080 O 0
O o Jo 10 o J0 110 O 0 108 10
O 0o 10 O J0 110 O 0 1080 O 0
O o Jo 10 o J0 110 O 0 108 10
O 0o 10 O J0 110 O 0 1080 O 0
O o Jo 1'0 o J0 1'0 O 0 7708 [0

[ Save ] [ Open ]

*» Type the actual image row numbers (i.e., the rows of the image
after binning) into the Y1 to Y2 fields for each curve band. A
"band" is the range of row numbers Y1 to Y2 that is used by the
curve.

* Select the Use button to activate the curve band.
* Repeat the above two steps for each desired curve band. You
can format up to 40 different custom curve bands. Bands may be

formed from overlapping areas of the image.

|:| * You must verify that no curve band is assigned a larger row (Y)
value than the the actual number of rows in the image.

» The Save and Open buttons let you save and recall custom curve
band formats.
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The Calibration Setupwindow appears when you select the Setup: X-
Axis Calibration menu. It has 15 pairs of edit fields for entering pixel
numbers and corresponding known wavelengths. A pop-up menu at
the lower left allows choosing the type of curve fit to be used to
generate a calibration curve "CAL curve" using the known-wave-
length pixels.

The CAL curve (curve memory 0) is computed when the "Update CAL
Curve" button is clicked.Only the pixels with the "Select” button on
(i.e., marked with an 'x") will be used in computing the CAL curve. You
can plot curve 0 to view the contents of the CAL curve; its plot displays
<calibrated unit> versus pixel number.

The "Use 1-Point Cal if Valid" ignores the CAL curve in favor of valid
KestrelCal 1-Point Cal information associated with a spectral curve.
Each curve has its own 1-Point Cal information(viewable in the Curve
Info window) which is valid if the "Known Pixel" value is greater than
zero. (See the next section for more details.)

CAL curves can be saved to disk and opened later using the
corresponding buttons in the Calibration Setup window. The wave-
length points used to create the CAL curve are automatically saved.

Make sure Points Per Curve is set to at least 1024 (use the Setup:
Curve Memories menu).Select the Setup: X-Axis Calibration
menuand enter the values and button selections as shown in the
figure below.

Select:

Pixel

Ualue

241

| S—

104.66 [ Open Cal Curve

334

660

435.83 [
546.07

| S—

Update Cal Curpve

7af

579.07

861

| S—

Save Cal Curve

| ]

614.306

1024

669.327

Laser Line (nm)[532.0 |

[Juse 1-Point Cal if Dalid

[ Setup 1-Point Cal... |

[ AutoStitch Setup... |

I e

Cubic

Spline

| Fit [ Cancel ]
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Next press the "Update CAL Curve" button. When the update is

0:Cald

V0. 7R
X= 138 # 0

T

finished, exit the Calibration Setup window by clicking OK. To
view plots calibrated with the CAL curve, slect the Style:Calibrate
X Axis:Wavelength {nm} menu. The X axis of every curve plot will
be displayed in nm according to the CAL curve you created.

~ To view the CAL curve, plot memory 0. (Press the "XY" button if

236 312
PIXEL

Excitation-
Profile Studies

you need to autoscale.) The calibration points are marked by
circles on the CAL curve plot.

1024

Raman-shift calibration requires labeling the X axis with the cm-1
frequency-shift values, where the shift is from the frequency corre-
sponding to the excitation (laser) wavelength. The cm-1 values are
automatically computed and displayed when the Style:Calibrate X
Axis:Raman Shift {cm-1} menu is selected.

You can also calibrate Raman spectra by directly entering known
cm-1 shift values and corresponding pixel numbers in the Calibration
Setup window, then selecting the tyle:Calibrate X Axis:Wavelength
{nm} menu. For such direct-Raman curve fits, the displayed X axis
label can be manually edited (e.g., to "Raman Shift (cm-1)" by
selecting the Set:Axes menu and typing the desired label into the X:
edit field.

In certain cases (e.g., Raman excitation profile studies) you may have
several spectral curves that were obtained using the same spec-
trograph setting (i.e., same emission wavelength range) but with
different excitation wavelengths. There are two different ways to
display overlay plots of excitation-profile studies. In either case, Select
the Style:Calibrate X Axis:Raman Shift {cm-1}menu. Leave the "Laser
Line (nm)" field in the Calibration Setup window blank and enter the
correct "Excitation Wavelength" value in the Curve Info window for
each spectrum. (To access the curve info window double-click on the
title of the curve or select the Display:Curve Info menu.) Then do as
follows:

(Method 1: lock to wavelength) Select the Set:Axes menu, turn on the
"Show All 3D X" button; this will cause the X axis labels to be drawn for
each curve in a 3D overlay plot. In this plotting mode, all curves points
will be positioned according to wavelength, but calibrated according to
Raman shift.

(Method 2: lock to Raman shiff) Select the Set:Axes menu, turn on the
"Linearize X" button. This will cause the postions of the plotted points
from each spectral curve to correspond to their cm-1 shift values. A
given Raman peak in a spectrum will then line up with the same peak
in all other spectra, regardless of excitation wavelength.
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1-Point KestrelCal™ 1-point spectrum calibration

Calibration The "traditional" way to calibrate spectrais by using a calibration curve
generated from a spline fit to known spectral points. Several spectral
reference points are required because of the inherent nonlinearity of
grating spectral dispersion. While accurate, this technigque has the
disadvantage that new spectral points must be located (and a new cal
curve generated) every time the spectrograph wavelength is changed.

KestrelCal 1-Point calibration takes a different approach. If the
wavelength for one sensor pixel wavelength is known, one can
accurately determine the wavelengths that correspond to all other
sensor pixels. Certain parameters concerning the spectrograph and
sensor characteristics are also required, which do not change when
the spectrograph wavelength is changed. These parameters are setup
using the Setup:: X Axis Calibration menu, then clicking the "Setup 1-
Point Cal..." button in the Calibration Setup window.

[ Setup 1-Point Cal... Iﬁ

Sspectrograph Info:

Known Wavelength

Spectrograph Angle =
Spec. Focal Length =
Grating Gruv. Density =
Detector Pixel S5ize =
Exdcitation Wavelen. =

Update Curve through

| 500

nm at Pixel | O

12.000001 Degrees

LS00 mm These values don't

change unless you
1200 g/MM [ change the grating
35 microns or move the detector.
457.9

om | (Ganeer) (o

 Set Pixel to the spectrum curve pixel corresponding to the Known
Wavelength. (Setting it to O disables KestrelCal.)

» Spectrograph Angle

Is the total included angle of your spec

trograph. Contact the spectrograph manufacturer if you don't
know this value.

» Spec. Focal Length may vary slightly from the nominal value,
depending on the actual detector position.

» Excitation Wavelen.

is the same as the "Laser Line (nm)" value

shown in the Calibration Setup window.
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Once the spectrograph information is setup, all newly-acquired
curves will have the KestrelCal spectrograph info automatically
attached to them. (The spectrograph info. associated with a particu-
lar curve is visible when the curve info. window is displayed.)

KestrelCal spectrograph information will be used in preference to
the cal curve (memory zero) for X axis calibration, unless "Use 1-
Point Cal if Valid" is turned off in the Calibration Setup window.

To disable KestrelCal for a particular curve, select the Display:
Curve Info menu and set the "Known Wavelength Pixel" to 0.

Dark-
Background
Subtraction

[]

Usually you will want to subtract dark (background) data during
data acquisition. There are two different background-subtraction
methods:

» Use Set Background - a dark image or curve ("background
blank") pre-stored in the Macintosh is subtracted after the data
is transferred. You must first set a curve or image as the back
ground blank using the Set:Set as Background Blank menu.

(A curve can be used as the background if only one spectrum
curve is made from the image; otherwise the background must
be an image.)

There are special curve- and image- memories for the background
blank. The background curve memory number is <maximum data
curve number + 2>, e.g., memory 52 for the default setting of 50
data curve memories.

» Dynamic background subtraction - a dark image is acquired
immediately before each exposure. It is then subtracted immedi-
ately after the exposure. This is the appropriate method if
the CCD temperature has not stabilized.
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Import Raw Data Import data as:
File Header Length @ Integers
m () Floating-point values
(Bytes)
Cancel 0K File has:
Pixels/Row @ 0ne or more columns
Bytes/Pivel )1 @2 4 © One column
Max Row No. |[AUTD C 0
ance
Ex Bytes/Row [0 | [ Start new curve(s) (cancer)
after every text header
[ Invert Byte Order

[]Signed Integer

Raw Data to Image... loads a binary integer image file (in
uncompressed row-by-row format) into the active image. A dialog
window automatically appears where the file header length, pixel-
byte size (1,2 or 4 bytes per pixel), row length and number or rows
are entered.

If you don't want to open all of the image, set Max Row No. to the
number of image rows to load.

Ex Bytes/Row is the number of extra (non-image) bytes at the end
of each image row. (Usually this is zero.)

Turn on Invert Byte Order to load 2-byte and 4-byte per pixel image
data created on IBM-type PCs. Turn on Signed Integer if the file
contains signed, 2-byte integer data.

PICT File to Image... converts any PICT file to a 256-gray level
image and copies it to a 16 bit/pixel active image. (For best results,
the PICT should be a grayscale image with at least 256 grays.)

Text File to Curve{s}... loads a text (ASCII) file into available
curve memory(s). The file can be in tab- or comma-delimited col-
umn format, or may be a single column. Any file rows (e.g., header)
that contain non-numerical information are automatically skipped.
An option allows automatically starting a new curve after every text
header.

Text File to CAL Curve... loads a text file into curve memory 0,
which causes it to be used as a calibration curve.
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Export Curves

['1gor Text' Format
[ 4 values in First Column

Separate

Columns With: -l:ancel
@ Tab (ASCII 9)
(> Comma (,)

The following items are accessed via the File:Export menu:

Export Curves{s} as Text... Saves the curve(s) currently shown in
the display window in tab- or comma-delimited, column format.
(This format can be opened by most spreadsheet- and analysis-
software.)

The first column can be set to contain the X-axis values, which will
be correspond to the currently displayed X axis calibration style.
Only the displayed X range is saved. If overlay mode is in use, it
will save the curves in the order in which they appear in the overlay,
starting with the rearmost curve in the plot.

Igor™ users can export files in Igor Text format.

Export Image as Raw Data... saves the image as a simple binary,
row-by-row data block without header or other information.

Export Image as PICT File... saves the image as a color 8-bit/
pixel PICT file.

The File:AutoSave menu lets you select the location on disk for
automatically saving curves and/or images. When you make this
menu selection, a file dialog widow will open. Use it to select the
disk folder where you want the data to be stored, then click OK.
Making this selection enables AutoSave mode and tells the system
where to automatically save data. Data will be automatically saved
to disk as it is received from the detector system.

AutoSave Curves as Text uses the format specified in the Export
Curve{s} as text dialog window. (The other autosave options save
data in the proprietary, binary format standard to this software.)

Once enabled, autosave remains in effect until this menu is again
selected and the "Cancel" button is pressed in the file dialog win-
dow.
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The File:Update PREFS File menu saves a special file that will be
automatically opened every time KestrelSpec starts up. It contains
information about various settings and graphics parameters. The
PREFS file must be left in the same folder as the KestrelSpec.

The following items are accessed under the File menu:

Set Print Margins...  opens a window with edit fields for setting the
printed page margins as percents of the total page width and
length. Turn on "Use Highest Resolution” and set the printing mag-
nification in the 'Page Setup' window to a small value (e.g., 25%) to
use the best possible printing resolution.

Page Setup... opens the standard Macintosh Page Setup window.

For best results in most cases configure the Page Setup as follows:
Orientation: "wide" or "landscape” format. Graphics Smoothing:
turned off. Font Substitution: turned off.

Reduce or Enlarge: set at 100% for normal plot resolution. When
the "Use Highest Resolution" button is selected in the "Print Mar-
gins" window, setting this value to 50% or 25% effectively doubles
or quadruples the numbers of pixels in the printed output, instead of
reducing the size of the plot. (The resolution of plots copied to the
clipboard is affected in a similar manner.)

Print... prints whatever is shown in the display window. The output
(plots, images) will be in full color when a color printer (e.g., DeskWriter
C) is used. High quality grayscale images can be obtained from a
printer with good grayscale capability, such as Apple LaserWriters with
PhotoGrade® or other laser printers with 600 dpi or better resolution.

Print All Curves... puts all curve memories on the keypad stack so
that each will be printed, one curve per page.
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The Edit:Paste Curve... menu opens a window where you enter
the range of pixels from the curve to be pasted, and the start pixel
for the curve to be pasted into. Any part of a curve can be pasted at
any location into any curve, including itself. This allows curves to be
manually joined together, or shifted along the X axis.

Edit:Auto-Join Curves  automates the pasting together of curves
that have valid KestrelCalspectrograph info data. (The spec-
trograph info data for a particular curve is accessed in the curve
information window.) The Auto-Join process finds the pixel location
in two curves where the wavelength matches, and joins the curves
together at that point.

Enter the range of curve numbers you wish to joinin the dialog window.

The total curve length (number of "pixels" or "points") must be long
enough to accomodate the joined curves. Increase the curve length,
if necessary, by selecting the Setup: Curve Memories menu.

Turn on Replace Original Curves if you do not want to keep the
original, separate curves.

The First Active Pixel and Last Active Pixel values should be setto
correspond to the range of pixels for which any curve could have
nonzero pixels. Auto-Join will ignore pixels not in this range.
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The Set:General Settings... menu opens the Settings window:

» Use Grid Lines - add dashed lines perpendicular to the X and Y
plot axes.

* Curve Info on Print - adds the curve info for the active curve at
the bottom of the printed page (or clipboard).

» AutoColor Overlays - colors the line for every 5th curve red
instead of black. It does not affect the paint fill color.

* Sound Effects - adds sound to certain actions, such as the Z
scroll button and editing in the catalog.

* Disable Warnings - turns off most alert and status messages
which warn the user about loss of data, etc. Also removes the
"grow icon" from the image display window.

» Transform is New Curve - a new curve memory is used for the
result of a smooth or other curve process. If this is not selected,
the original curve will be replaced.

* Round Off Y Labels - round numbers on Y axis of plots to 3
significant digits.

» Off-Screen Drawing - use memory-buffered plotting.

* Flash Active Curve - active curve in overlay is continuously flashed.
* Auto <Y> Scale - autoscales min,max Y values.

* AutoShow New Data -updates display for each new curve orimage.
* Auto Image Brightness - sets the brightness automatically.

* Clear Curve Before Scan - erase curves before acquiring new data.

 Auto Spike Filter -newimages are filtered for spikes. Use only when
you know that the smooth/peak threshold control is properly adjusted.

» Get Log of New Curves - takes log base 10 of curve during scans.
(Requires Macintosh with FPU math coprocessor.)

» Always Show Cursor - the X,Y position cursor is always shown.
» Copy Plots as Object Drawings to Clipboard - creates an object-

oriented PICT drawing which has each element (axis, etc.) as a
separate object.
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Set:Axes... opens a window where the scales and format of the plot
axes are set. (A double-click on plot axis will also open this window.)

Set X Cursor Range causes the range for the XY cursor scroll button
to be limited to the current X Min and X Max values.

Show All 3D X - each curve in 3D plot will have X axis labels drawn.

Linearize X makes plotted pixel positions correspond to their cali-
brated wavelength- or Raman shift- values. When Linearize X is
enabled, X Min and X Max are specified directly in the current X-axis
display units (pixels, nm, or cm-1 shift). It forces the X Min and X Max
to "lock in" onto values specified in nm or cm-1.

The X-axis label should be left as <AUTO> except to override the
default settings of "PIXEL," "WAVELENGTH nm," and "RAMAN
SHIFT cm-1." Y- and Z- (channel profile) labels are used as entered.

Set:Thresholds... sets values used for smooth , spike-filter (and
flat-field notch-filter region , when flat-field blank is a curve) pro-
cesses and for finding peaks in curves. The correct settings will
depend on the background noise level in the data. Set peak and spike
thresholds to O to find every curve peak or filter every image spike.
Adjust smoothing threshold to a large value to smooth all points in a
curve. The flat-field notch settings cause values in the notch region of
a flat-field curve to be set to a very large value, effectively zeroing the
pixel values of flat-fielded curves in that region.

Threshold Settings

Peak Finder 20
Curve smoothing 100

Suppress
Image spike filter | 500 flat-field

notch region by:
Flat-field curpve
notch filter (%) -3 @ % Threshold
Flat-field curve (i Left, right pixel
min value (%) 05
Flat-field curpe
notch (left pixel) 1
Flat—flel_d curl._le l | Cancel | || 0K |
notch (right pixel)
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The Set:Peak Finder menu is used to set

* the number of peaks that will be automatically located on the first
click

» whether the peak width (used for peak-area calculation is deter-
mined automatically (x1.5 FWHM) or manually .

* the Baseline Correct setting causes the peak finder to compute
baseline-corrected peak areas

» Save Peak Info causes data for peaks to be automatically saved
to disk (during live scanning or when the peak finder is quit). The
saved data includes peak pixel, wavelength or cm-1 value (if using
a calibrated axis), height, full width half max (FWHM) and area. The
data is saved in tab-delimited ASCII text format with a single
header row of column titles.

» Get Centroid causes the peak pixel location to be determined
from the centroid (5-pixel weighted average) location. This method
of peak location can yield more precise results. It is recommended
that this setting be enabled when locating peaks for generating a
calibration curve.
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The Set:Auto Background Subtraction menu enables the automatic
subtraction of a dark background reference (image or curve) from
newly acquired data:
Use Set Background Curve: A curve that has been set as the
background will be subtracted from each new curve input from the
camera. (For curve background subtraction, the setup must yield 1
curve from the entire image.)
Use Set Background Image: If an image has been set as the back-
ground blank (using the Set menu), it will be subtracted from each
new image input form the camera.
Dynamic Background Image: A new, dark background image will be
automatically acquired (i.e., an exposure with the camera shutter
disabled) and subtracted after every exposure.

Auto Transform to Absorbance - new data is automatically
converted to absorbance (optical density) values. The absorbance
blank memory (Maximum Curve No.)+3 must be previously set. This
function only works when 1 curve band is selected in the "Image
->Curve{s} " window:

Auto Flat-Field Correct - new data is automatically normalized for
variations in pixel response by (i) dividing by the flat-field blank and
(i) multiplying by the average of the flat-field blank. The flat-field
blank image or curve (Maximum Curve No.)+4 must have been
previously set with the Set menu.

Set as Background Blank - copies the active curve or image to
the background reference memory. If an image or background
image is displayed, the background image buffer is updated and set
as the permanent (static) background; otherwise the active curve is
copied to memory (maximum curve no. + 2) and set as the perma-
nent background. To undo the set command, clear the background
image or curve memory (max. curve +2) with the Edit:Clear menu.

Set as Absorbance Blank - copies the active curve to the absor-
bance blank reference memory (max. curve +3). Can only be used
when data from the image is transferred to a single curve memory,
i.e., when 1 curve band is selected in the Image->Curve(s) Window.

Set as Flat-Field Blank - :This Data copies the active curve (max.
curve +4) or image to the flat-field blank. :File opens a curve or
image from disk and sets it as the flat-field blank. The flat field
should be obtained by exposure with uniform, white light. The
"noise" created a wavelength-notch filter with a flat-field curve can
be suppressed by settings in the Set:Thresholds... menu.
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* Plot selects the way the outline of a spectrum graph is drawn.

* Line selects a color (red, green, blue, yellow, cyan, magenta,
black) for the plot line.

* Fill selects the color that is used to fill the inside of the plot of a
curve. (The exact meaning of "inside" depends on the plot style.)
Choosing Color ... opens the color selector window on Macs that
have color QuickDraw. The number of different custom fill colors is
determined by the number of colors displayable on your monitor,
e.g. 256 colors for 8-bit monitors.

In overlay plots , the selected plot style, line- and paint- color are
automatically applied to new curves added to the overlay.

To change the active-curve style in an overlay plot, select the
desired characteristics with the Style menu, then choose the
Edit:Overlay:New Style on Active Curve menu.

* Image allows selecting between positive grayscale, negative
grayscale, and 23-level pseudocolor image display palettes. It also
has the following items:

Show Intensity Scale - adds a legend at the right edge of the
image display for the relation between color (or gray level) and
intensity. Using the legend, a color of a pixel in the image can be
assocated with an intensity range. (For negative darkness settings
less than -3 not all legend colors are actually used in the image.)

Show Negative Pixels - all pixel values will display according to
their absolute value. When turned off, negative pixels are displayed
as zero value.

Dither Image Display - Simulates additional colors on devices
with fewer than 256 colors or grays. (Image-display updates are
significantly slower.)

Image Fits Window - the image is streched to fit the display
window.

X, Y Profile Plot - add graphs of the the intensity for the center
column and/or row of the image. The profile lines can be dragged
with the mouse, or moved with the arrow keys on the keyboard.
(Hold down the option key to make the arrow key move the profile
line 10 pixels at a time.)
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Smooth reduces low-level noise fluctuations in the active curve while preserving "real”
peaks. (Use the Set:Thresholds menu to adjust the effectiveness of this process.)

Flatten Baseline finds peaks and subtracts the local baseline intensity value from each
one. (Use the Set:Thresholds menu to adjust the effectiveness of this process.)

Convert to Int/Float- selecting this changes the active curve from integer to floating
point (or vice versa). Integer-format curves plot faster than floating-point curves. Float-
ing-point curves have greater dynamic range, as well as better precision at small count
values. (An exception is the Cal curve, memory 0, which must always be in floating-
point format.)

Derivative dy\dx computes the first derivative (slope) of the active curve, on a pixel-by-
pixel basis.

Create Baseline... - lets you fit an nth order polynomial to selected points for baseline
subtraction. See detailed description on next page.

Curve math... opens a dialog window that enables arithemtic operations (+,-,/,X) on
one or more than one curve at a time. Use it, for example, to subtract the same curve or
constant value from a range of curve memories.

Stretch Curve {Resample} changes the number of pixels in curves. The process uses
a nonlinear interpolation kernel that minimizes aliasing effects while optimizing retention
of genuine data characteristics.

Renormalize Curve X Axis takes the active-curve pixels and maps them onto uniformly
spaced pixels of arbitrary wavelength interval. The active curve must have valid calibra-
tion information (Cal curve or KestrelCal spectrograph info). See the detailed discussion
of this process on the next page for more information.

Copy Image to Curve{s} - copies the active image to curve memories, using the format
specified by the Setup: Image->Curve{s} menu.

Remove Image Spikes - applies the spike filter to the active image. (Use the
Set:Smooth, Peak Threshold menu to adjust the effectiveness of this process.)

Subtract Background Image - subtracts the background image from the active image.

Flat-Field Correct Image - first multiplies the active-image pixels by the average of the
flat-field pixel values, then divides the active image by the flat-field image.

Flip Image Horizontal - active image is transformed to its "mirror image".
Flip Image Vertical - active image is inverted top-to-bottom.

Image->{+,-} Integers; Image->{+} Integers - switch the displayed image between
signed and unsigned integer type.
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Spectra often contain narrow peaks which are offset along the
intensity axis by varying amounts due to a relatively broad
backgrond, or "baseline." One can generate a "baseline" spectrum
which represents the original spectrum minus the narrow peaks.
The baseline spectrum can then be subtracted from the original
spectrum to effectively flatten its baseline.

The Process:Curve:Create Baseline... menu lets you select up to
99 baseline points in the active curve by clicking on them in the
curve-plot display. Each selected point is outlined by a circle as
shown in the figure below. Use the Edit:Undo menu to unselect the
last-selected point. Clicking on any selected point will unselect it.

-850 437.5 1825 31625 4500

RAMAM SHIFT cm—1

When you are finished selecting baseline points click the OK button
on the Control Palette, or press return on the keyboard. The se-
lected points are fit to a polynomial of user-specified order 1
through 10, and the new (baseline) curve is placed in the next-
available curve memory. The baseline curve is computed for the
range of displayed points. The new curve will have the numerical
format (integer or floating point) of the original curve.

As shown in the overlay plot below, you can subtract the computed
baseline curve from the original spectrum to flatten the baseline,
while preserving all fine structure in the spectrum.

20000

=1700

133200

=3000

1

1:DATA 17
Si# | - # 4
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Renormalize
Curve X Axis

The wavelength (or Raman cm-1 shift) resolution of an array
detector depends on pixel size, spectrograph focal length,
grating density and other factors. The wavelength (or Raman
cm-1) range covered by a pixel also varies depending on its
position in the array.

However, one often needs to display spectral data with the
curve-pixel resolution in some standard, uniform unit such as
1.0 nm per pixel. The Renormalize Curve X Axis process
enables you to transform any calibrated spectrum curve into
a new curve with uniform pixel resolution that you specify.

Unlike many other types of interpolation process,
Renormalize X Axis is well-suited for transforming spectral
data because it preserves the total area of the spectrum and
it does not distort line spectra. To use it, do the following:

* Plot the curve you want to renormalize. (In an overlay
plot use the Z scroll button to make it the active curve.)

* Select the Process:Renormalize Curve X Axis menu. For
KestrelCal-calibrated spectra the watch cursor will spin
for a few moments while temporary calibration data are
computed.

* Type the lower- and upper- wavelength limits you want the
new spectrum to cover in the From Wavelength and To
Wavelength fields. (If the plot display is in Raman mode,
these limits will be in cm-1 Raman shift instead of nm.)
Zeros will be used for the intensity (count) values
whenever the requested wavelength (or Raman cm-1)
range extends outside the range of the active curve.

* Type the desired pixel resolution for the new curve in the
Interval Between Points field. Spectral resolution will be
reduced when the new curve has lower resolution than
the original spectrum. If the interval corresponds to a
much smaller pixel interval than the original curve, you
may get better results if you first stretch the curve before
renormalizing it. (The stretch process minimizes aliasing
effects associated with generating a smaller interval.)

* Click OK to generate the renormalized curve. The new
curve will have appropriate KestrelCal information auto-
matically attached to it. The new KestrelCal parameters
represent the slope and intercept of a straight line, since
the renormalized curve has, by definition, perfectly linear
wavelength (or Raman cm-1) dispersion.
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The area of peaks ("regions”) can be calculated using the
Process:Integrals menu. You can also create Y(t) [peak area
versus curve number] spectrum curves from each of the defined
regions.

Peak areas ("integrals™) are calculated in one of two ways:

(1) The sum of all of the intensity values beween (and including) a
lower bound ("Pixel 1") and an upper bound ("Pixel 2") is given
when the Baseline Correct button is not selected.

(2) When Baseline Correct is selected, a baseline function is
calculated. This corresponds to a line drawn from the intensity
value at Pixel 1 to the intensity value at Pixel 2. The integral is the
sum of the difference between the the intensity values and the
baseline (see figure below).

The baseline-corrected
integral between Pixel 1 and
Pixel 2 is represented by the
shaded area.
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7 1~
Pixel 1 Pixel 2

» Computing Peak Areas

Enter the Pixel 1 and Pixel 2 numbers for each integration region.
Click the Calc button to calculate the integrals. Type a different
number in the Memory-> field or press the " <-" or "->" button to
change the memory for which the integrals are calculated. Press-
ing Clear erases all fields. (The regions are automatically saved
and reloaded with the Cal curve file.)

You can select the Pixel 1 and Pixel 2 values using the XY position
cursor and the Int button in the control palette, rather than type
these values directly into the edit fields. Position the cursor at the
left side of the region, then click/nt. A marker (]) will appear above
that point, and a message will show in the upper left corner of the
display to identify the pixel and region number. Move the cursor to
the right side of the region and press Int again.

When there is more than one curve in memory, the Make Y(t)
Curves button is active. It creates, for each integration region, a
new curve that shows the integral value ("Y") as a function of curve-
memory number ("t"). If an overlay plot is currently displayed, only
the curves in the overlay will be used to create the Y(t) curve(s). If
there is no overlay plot, all curves in memory are used to generate
the Y(t) curves.
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* Problem : The ST-6 system appears to be functioning normally but the data is
blank (all zeros).

Solution : increase the video offset (use the Setup:Camera Configuration
menu) until the the video reading is between a few hundred and a few thousand
counts. Or choose the Setup:Auto Set Video Offset menu and KestrelSpec will
find the set the correct value.

* Problem: The ST-6 system appears to be functioning normally but the data is
the same for all pixels.

Solution: The data is saturated because (1) the light source is too strong, or (2)
the video offset is too high. First check the video offset to verify that it is properly
set. If this is not the problem, try reducing the light source or exposure time.

» Problem: The image display looks "posterized," and the intensity- scale colors
don't seem correct.
Solution: Set the monitor control panel to at least 256 colors, if available.

» Problem: It takes a very long time (over 30 seconds) to acquire a spectrum or
image, even though the exposure time is short.

Solution: The ST-6 is set for an a imaging (as opposed to spectroscopic)
resolution mode, such as 375x242. Use the Setup: Binning menu to select a
spectroscopic resolution mode such as 750x30. You must have either an ST-6l
or ST-6V model to support spectroscopic binning modes.

* Problem: The Mac "freezes" when data is being read from the CCD, requiring a
reset of the system.

Solution: The Mac CPU is being interrupted by a process other than the serial
(modem) port, which confilcts with the interrupts required to read the CCD data.
This problem is noticed on slower Macs, depending on system software configu-
ration. Solutions, in the order that they should be tried, include: (1) Disable
AppleTalk in the Chooser, (2) Disable Virtual Memory (use the Memory control
panel), (3) turn on 32-bit addressing (also in the Memory control panel on some
Macs), (4) remove non-essential system extentions (INITs) from the
System:Extensions folder. If the above fixes are unsuccessful, select a slower
RS232 baud rate (e.g., 9600 or 19200) with the pop-up menu in the window that
appears when the Setup:Camera Configuration menu is selected.

KestrelSpec ST-6l and the Kestrel Macintosh ST-61 camera system can be used
with any Macintosh having at least 2 MB RAM and System 6.0.5 or later. A
Macintosh with at least 8-bit color or grayscale display and system 7.0 or later
and at least 4 MB RAM are recommended. Recommended computers include
the Macintosh LC, Classic Il, Color Classic, Macintosh Il series (all models),
Centris, Quadra, and PowerBook series (except model 100), as well as Power
Macintosh models.

The interface to the ST-6 camera uses the Macintosh modem port at up to 57600
baud (effective 114 kbaud rate with data compression). The KestrelSpec spec-
trograph control option uses the Macintosh printer port at 9600 baud, or (depend-
ing on spectrograph model) a National Instruments GPIB (IEEE-488) interface.
PowerBook 200/500 series models require a docking station or other adaptor that
separates the modem and printer ports if the spectrograph control optionwith RS-
232 interface is used.
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KestrelSpec offers the ability to control the operation of certain
spectrographs. (This is an optional feature that must be specified

for your licensed copy of KestrelSpec.)

The KestrelSpec spectrograph control option consists of two parts:

(a) the spectrograph control palette, which is a "pull-down" exten-
sion to the normal Control Palette window, and

(b) an extension to the Acquire setup window, which allows
automatic stepping of the spectrograph during a programmed
sequence of scans.

(The figure below applies to CVI Laser DK240, Chromex

Spectrograph Control
Palette Extention

Slit controls.

These fields set the
entrance- and (if installed) exit- slit

250,500 models. See next page for SMS LambdaScan version.)

Revert and Set buttons. Press "Revert" to undo any changes made
in one of the edit fields. Press "Set" (or the "enter" key on the keyboard)
to register changes in settings with the spectrograph. The "OK" symbol
appears at the left of a field when the spectrograph actually has that
setting. A "£" symbol will appear instead for settings that have not yet

been sent to the spectrograph.

Spectrograph wavelength
controls. Selectthe "cm-1"but-
ton to reads out spectrograph
setting directly incm-1 Raman
shift. The single-arrow keys (<-
->) makethe spectrograph scan
up or down in wavelength at
slow speed. The double-arrow
keys (<<, >>) make the spec-
trograph scan more rapidly.
The"SCANRATE" setting con-
trols (depending on spec-
trograph model) either the
slower(->) or faster (->>) scan
speed.

Spectrograph scan-rate
control. This edit field sets
the speed at which the spec-
trograph will scan when the
single-arrow (<- , ->) buttons
are pressed.

Grating selection

pop-up menu.

Select from up to 3 gratings.
KestrelSpec automatically
shows youthe grating groove
densities. Depending on
spectrograph model, you may
have to select the grating
before its groove density is
shown in the menu.

sizes.

Logo that identifies the brand
and/or model of spectrograph
controlled by your copy of
KestrelSpec.
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Filter selection pop-up
menu. This menu allows for
selection from up to six differ-
ent filters installed in the op-
tional input-filter accessory
holder. The menu reads "no
filter" if the accessory filter
wheel is not installed.

AutoCalibrate button. Press this
buttonto automatically calibrate your
spectrograph-detector system
against a known spectral line, or a
white light source. See the next page
for details.
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(Only features that differ from the description on the previous
page are listed below.)

Step Delay: sets the delay between steps of the wavelength-
scanning motor; range is 0-255. Maximum delay (255) corre-
sponds to somewhat less than 1 s delay per step.

Spectrograph Type: set this pop-up menu to
the SMS spec’rrogrm/oh you are using.

Ok | 449.9531 | nm

A (om-1

ok [1 ] ok [ 3z M [Heuért][ﬂet] LambdaScan 937
STEF DEL &Y o[ .20 | o / by SM3

Grating Pop-Up
Menu: set this to
the grating that
is actually in use
inthe spec-
trograph. (The
actual grating
selection is
done manually.)

Multiplier and Offset: set the corresponding values used by
the LambdaScan controller,

The Mulitplier value is number of steps the wavelength-conftrol
motor must take to change the actual center wavelength of
the spectrograph by 1.0 nm. The Multiplier value is deter-
mined automatically from the "Spectrograph Type" and "Grat-
ing" pop-up menu seftings.

The Offset value is the "zero" reading (i.e., the setting auto-
matically reset when the LambdaScan controller is turned on
or the grating menu is changed) of the mechanical wave-
length counter on the spectrograph, in raw units (i.e., not
corrected for grating type). To set up the Offset value, wait
until the spectrograph has reset after turning on the
LambdaScan and pressing the "Enter" button on the
LambdaScan controller. The value on the mechanical
counter is the Offset. (KestrelSpec automatically corrects the
raw counter value for the selected grating before updating
the LambdaScan controller.)

The Multiplier and Offset values are "'remembered" by the
LambdaScan controller when it is turned off, so they do not
have to be re-entered. Due to mechanical variations, the
Offset value often has to be changed when a different grat-
ing is selected.
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75
KestrelSpec (with the spectrograph control option) can automati-
cally calibrate the wavelength (or cm-1 Raman shift) axis of your
spectral curves. To use the AutoCalibrate feature, follow these
steps:

(1) Have a known spectral line located near the center (£20%) of
the detector array. This line must be the highest peak in the field
of view as the spectrograph is scanned over a small range. Enter
the wavelength for this line in the wavelength-control edit field.
Register the new wavelength setting with the spectrograph by
pressing the "Set" button (or "enter" on the keyboard).

(2) Click the "AutoCalibrate" button. KestrelSpec will obtain 3 data
acquisitions while it automatically changes the spectrograph
wavelength setting.

(3) Wait for the scans to finish (this may take a few seconds). The
wavelength axis will then be calibrated for all pixels, even when
the wavelength setting of the spectrograph is changed.

The AutoCalibrate method updates the spectrograph information
parameters (accessed from the Setup: X-Axis Calibration:1-Point
Cal menu). These parameters include the spectrograph focal
length, total included angle between spectrograph mirrors, detec-
tor pixel size, and center-focus pixel. The first three of these
parameters are read directly from the spectrograph by
KestrelSpec.

AutoCalibrate automatically finds the center focus pixel, and then
uses the detector pixel size as the one adjustable parameter
during the autocalibration scanning procedure. The computed
pixel size determined may vary slightly from the actual pixel size,
since the actual focal distance and grating groove density may be
slightly different than the nominal values reported by the spec-
trograph.

This information is then used to extract, using the diffraction
equation, the correct wavelength values that fall at any pixel on
the detector array.

Raman cm-1 shift values at each pixel are directly computed from
the individual pixel wavelength values and the laser excitation

wavelength specified with the Setup:Spectrograph menu.
Itis possible to obtain approximate calibration with the AutoCalibrate

procedure using "white" light (or any light source). Set the spec-
trograph to zerowavelength (0.0 nm) and adjust the light intensity so
that the detector sees a narrow peak in the middle of the array. Press
the "AutoCalibrate" button. The wavelength axis and spectrograph
information parameters will be updated as described above.
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Connecting KestrelSpec with the spectrograph control option can control

the supported spectrographs via either an RS-232 or (certain

Spectrograph spectrograph models only) GPIB interface connection.

to yqur * All supported spectrographs include an RS-232 interface as

Macintosh standard equipment. Connect the appropriate RS-232 cable
between the printer port of the Macintosh and the RS-232
("Host Computer") port on the spectrograph. Certain Mac
models (e.g. PowerBook Duo, PowerBook 500 series) require
a docking adaptor to supply the separate printer port. The
spectrograph manufacturer can supply the required Macintosh
interface cable.

GPIB * If your spectrograph is one whose GPIB (IEEE-488) commu-

Interface Option

nication is supported by KestrelSpec, you can use a National
Instruments GPIB interface (NB-GPIB or NB-TNT card, or
GPIB-SCSI adaptor box) to connect the spectrograph to the
Macintosh.

Use the NB Handler Init control panel supplied by National
Instruments to name the device "specA " on bus gpib0 at the
GPIB address set on the spectrograph. (For information on
setting the spectrograph GPIB address, consult the spec-
trograph manual. In the example window below the spec-
trograph was set for GPIB address 8. Set the Timeout at 3
sec. The presence of the GPIB interface will be automatically
detected at start-up.

Configuring the GPIB (IEEE-488) Spectrograph Interface:

(1) Setup GPIB interface: (2) Setup spectrograph:
=[[I=== NB Handler INIT =—— [E[lI=-- NB Handler INIT
Mational Instruments GPIB Configuration Mational Instruments GPIE Configuration
Inte-r'face-: 1 2 3 4 3 & Inter'face: 1 2 3 4 5 &
(<] auta OO0&EO00 (<] aute OO0EO0O0
<Ini-432 pus®. o Ini-422 pus®: Q0

Bus /Device : [apibl

| Bus /Dewice : [ SpecA | I:Eename:I

(<] REM when SC

[ ]orMa

Secondary :

. : b0
[] rite END on Last Byte | | W52 BUS: <] "rite END on Last Byte
Primary: [0 ] []write END on EOS Primary : []%rite END on EOS

[Jread EMD on EOS Secondary : [Mone | []Read END on EOS

Timeout E0s Byte [ O] [eeit || Timeout:[__3 sec] E0SEyte [ 0] [JeEit

E Systermn Controller E Repeat Addresszing
E Unaddressing
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Using Trigger
Out
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You can enable triggered data acquistion if the ST-61 ROM
version is 3.05 or 3.07. The TTL-compatible trigger signals appear
at the AUX port on the ST-6I conftroller (diagram below).

AL
9@
o
o
@ ——TriggerIn (+) N
o Trigger In (-) —
@1 ——Trigger Out (+)
6 @ Trigger Out (-)
& .
20.4 ms

(max)
ST-61 "AUX" Port Connections for Triggered Data Acquisition

When the Setup:Camera Configurtion menu is setup to enable
TriggerIn, pin 3 of the AUX port willwait forahigh TTL (+5 volt) level
with respect to electrical ground before taking an exposure. (If
desired, the logical complement, i.e., 0 volts, can instead be
applied to Pin 7 to trigger the exposure.) The trigger level must
remain valid for a minimum of (1/baud rate) second; at 9600
baud the minimum trigger pulse width is thus 0.104 ms.

Once the trigger-in level is detected, the CCD exposure begins
after a latency period which is in part associated with clearing
the CCD and, to a smaller extent, due to the AUX port response
fime. The latter depends on the baud rate in use. The maximum
total latency time (using 2600 baud) between the trigger-in
signal and the actual start of exposure is 20.4 ms, asshown in the
diagram. The minimum latency time (using 57600 baud) is
approximately 19.5 ms.

When the Setup:Camera Configurtion menu is setup to enable
Trigger Out, pin 2 of the AUX port willmake a transition from zero
volts to a high TTL (+5 volt) level with respect to ground at actual
start of an exposure, i.e., the pulse appears after the CCD has
been cleared and coincident with the start of integration. (The
logical complement of this signal appears at Pin 6.)



